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Gmail

1. Login to the gmail account you want to forward email FROM.
2. Click the gear icon, then Settings in the upper-right corner of the page.
3. Click the Forwarding and POP/IMAP link.
4. Click the Add a forwarding address button.
5. Enter the email address TO which you want your email forwarded, then click Next.

 A confirmation email is sent to the email address you specified in this step.
6. Login to the email account you are forwarding TO in a different web browser (or in your

email client) and confirm the forwarding using one of the following methods:
Click the link in the confirmation email.
- or -
Copy the confirmation code in the email and paste it into the text box on the
Settings > Forwarding page on the account you want to forward FROM.

7. Refresh the Settings > Forwarding page and verify that "Forward a copy of incoming
email to" is selected.

8. Click the Save Changes button at the bottom of the page.
 All email sent to the email address you configured to forward FROM will be forwarded to
the email address you entered to forward TO.

For more information see the Google support page Automatically forward Gmail messages to

another account.

Configure Forwarding in
Gmail

https://support.google.com/mail/answer/10957?hl=en&ref_topic=7280290
https://support.google.com/mail/answer/10957?hl=en&ref_topic=7280290


Gmail

Configure your gmail account to retrieve email from your other email accounts:

If the email account you want to retrieve email from is a gmail account, you will need to enable

POP on that gmail account. See Configure Forwarding in Gmail to forward your emails from
another gmail account.

If necessary, enable POP on the gmail account FROM which you want to retrieve email.
Instructions for enabling POP on your gmail account are available from Google here:
Read Gmail messages on other email clients using POP.

To retrieve emails from another account to your Gmail, see Google's help page: Check

emails from other accounts. 
Then, follow the instructions under the "Get all messages" section. To import old
archived emails, see the "Get only old messages" section.

See the page Fix problems importing mail for troubleshooting issues.

Retrieve Email from your
Other Email Accounts using
Gmail

https://kb.mlml.sjsu.edu/books/g-suite/page/configure-forwarding-in-gmail
https://support.google.com/mail/answer/7104828?hl=en&ref_topic=7280141
https://support.google.com/mail/answer/21289
https://support.google.com/mail/answer/21289
https://support.google.com/mail/answer/7239777


Gmail

Did you know you can use filters to automatically label, archive, delete, star, or forward your mail
based on keywords, senders, recipients, and more? Start to organize your mail with these simple
steps.

To create a new filter:

1. In Gmail go to Settings (at the top-right under the gear icon) --> Filters and Blocked
Addresses --> Create a new filter

2. Enter your filter criteria in the appropriate field(s). You can enter information in one or
several fields to specify what to filter:

"From" - emails from a specific email address
(ex. "studentbody@mlml.calstate.edu, another personal address you have set up to
forward, or an E-newsletter you receive)
"To" - emails sent to a specific address
(ex. "faculty@mlml.calstate.edu, or a listserve you belong to)
"Subject" - any emails with keywords in the subject
(ex. "Open House" or "Seminar")
"Has the words" - any emails with these keywords in the body of the email
(ex. a grant number or the name of a class you are taking)
"Doesn't have" - any emails without keywords

3. Click Create a new filter.
4. Select one or more actions from the list. These actions will be applied to messages

matching your filter criteria in the order in which the actions are listed
For example, choose to apply a certain label to your filtered emails so it places them
in categories (like folders); or you could choose to Forward matching messages to a
specific email address, then Delete the messages; or you could send certain
messages directly to the archive so that they don't clutter up your inbox.

5. If you'd like to apply this filter to messages already in Gmail, select the checkbox "Also
apply filter to x matching conversations".

6. Click Create Filter.

 

To create a filter from within a message:

Using Filters in Gmail to
Organize Incoming Mail

mailto:studentbody@mlml.calstate.edu
mailto:faculty@mlml.calstate.edu


1. Click the drop-down menu (three vertical dots on the upper right).
2. Select Filter messages like this.
3. Enter your filter criteria in the appropriate field(s) as described above.

 

To edit or delete existing filters:

1. Click Settings --> Filters and Blocked Addresses.
2. Find the filter you'd like to change and click its edit link, or click delete to remove the

filter.
3. If you're editing the filter, enter the updated criteria for the filter in the appropriate fields,

and click Next Step.
4. Update any actions and click Update Filter.

You can create an unlimited number of filters, but only 20 filters can forward to other addresses.
You can maximize your filtered forwarding by combining filters that send to the same address.
More information on this topic can also be found here.

https://support.google.com/mail/answer/6579?hl=en


Gmail

WARNING!: Before deleting any email messages or attachments from your Gmail account, be sure
to backup any important email messages to your computer using an email client or Gmail Backup.

Instructions for backing up email messages are located here.

There are a few different methods to free up space in your Gmail account:

1. Use the Gmail web interface (described below)
2. Use IMAPSize to delete large attachments (Windows only)
3. Use an email client - see this Knowledge Base post: Delete Batches of Email Using an

Email Client

Delete messages using the Gmail web interface: The easiest and fastest way to free up space
in your Gmail account is to delete batches of email messages within a specific date range using the
web interface

1. Login to your Gmail account: https://mail.google.com/a/mlml.calstate.edu/.
2. Click the All Mail link on the left side of the page.

(You may have to click the "more" link for the All Mail link to be visible)
3. Enter the date range in the search box in the following format: before: YYYY-MM-DD

(For example to search for mail from 2008 and earlier, enter: "before: 2009-01-01")
4. Click the Select All link (the little blank box with downward arrow in the upper-left corner

of the panel), then click the Select all conversations that match this search link
5. Click the Delete button to delete all email messages contained within the date range of

the search. The email messages are then moved to the Trash.
6. Click the Trash link, then click Empty Trash now.
7. Click OK to confirm.

 

To free up space in your local email client software, and avoid duplication, when
syncing from gmail:

Free Up Space in your Gmail
Account

https://kb.mlml.sjsu.edu/books/g-suite/page/how-to-archive-your-mlml-gmail
http://www.broobles.com/imapsize/index.php
https://kb.mlml.sjsu.edu/books/g-suite/page/delete-batches-of-email-using-an-email-client
https://kb.mlml.sjsu.edu/books/g-suite/page/delete-batches-of-email-using-an-email-client
https://mail.google.com/a/mlml.calstate.edu/


1. Navigate to the gear icon at the top right. Click it.
2. In the menu that drops down, click Settings.
3. Go to the tab Forwarding and POP/IMAP.
4. In the "IMAP Access" confirm that IMAP is Enabled.
5. Now, go to the Labels tab.
6. Uncheck the Show in IMAP box to the right of All Mail
7. These settings should autosave, exit the settings dialog.
8. Get Mail or the equivalent, from your mail client software. This should now sync, and

keep your mail client from downloading duplicate emails.



Gmail

You can quickly export your Gmail Contacts list into a downloadable file. Here's how:

1. Go to Google Contacts.
2. From the More drop-down menu, select Export....
3. Choose whether to export all contacts or only one group.
4. Select the format in which you'd like to export your contacts' information. Please note,

some of these formats can lose some contact information.
To transfer contacts between Google accounts, use the Google CSV format. This is
the recommended way to back up your Google Contacts.
To transfer contacts to Outlook, Yahoo! Mail, Hotmail, or various other apps, use the
Outlook CSV format.
To transfer contacts to Apple Address Book, use the vCard format.

Exporting Gmail Contacts

https://contacts.google.com/


Gmail

Gmail signatures are text that appear at the footer of your email message. Email signatures can be
tested by composing a new email message. Your signature should appear at the bottom of your
email message.

For more information on creating a Gmail signature click here.

How do I attach a signature
in Gmail?

https://support.google.com/mail/answer/8395?co=GENIE.Platform%3DDesktop&hl=en


Gmail

You can 'whitelist' an email address to ensure it is not marked as Junk Mail by Gmail.

In Gmail, if a message is inappropriately identified as spam, you can unmark the message. Just
select the message, and click the "Not Spam" button that appears at the top and bottom of your
current view. Marking a message as "Not Spam" will result in the email message being
automatically moved to your Inbox.

Alternatively, if you would like to prevent this in the future, you can add the sender's email
addresses to your Contacts list. Click here for instructions to import your contacts into Gmail.

How do I keep certain emails
from ending up in Junk Mail
in Gmail?

http://mail.google.com/support/bin/answer.py?answer=8301&topic=12877


Gmail

According to Google's website:

"Google has one of the best spam blockers in the business, and it's integrated into Google Apps.
Spam is purged every 30 days. We have built in virus checking, and we enforce checking of
documents before allowing a user to download any message. Most computer viruses are contained
in executable files, so standard virus detectors scan messages for executable files that appear to
be viruses. Google blocks viruses in the most direct possible way: by not allowing users to receive
executable files (such as files ending in .exe) that could contain damaging executable code; even if
they are sent in a compressed (.zip, .tar, .tgz, .taz, .z, .gz) format."

For more information on how Google filters Spam and viruses please see the Google Security
Services website.

How does Gmail filter spam
and viruses?

https://support.google.com/a/answer/60762?hl=en
https://support.google.com/a/answer/60762?hl=en


Gmail

If you need to export your contacts first click here.

Instructions for importing contacts from a CSV file can be found in Gmail Help here:
https://support.google.com/mail/answer/ ... ic=3397492

 

For more information see:
https://support.google.com/mail/answer/ ... ic=3397492

How do I import my contacts
into Gmail?

https://kb.mlml.sjsu.edu/viewtopic.php?f=10&t=689
https://support.google.com/mail/answer/14024?hl=en&ref_topic=3397492
https://support.google.com/mail/answer/12118?hl=en&ref_topic=3397492


Gmail

For instructions on setting up an email auto-reply on Gmail click here.
 

How do I setup an email
auto-reply on Gmail?

http://mail.google.com/support/bin/answer.py?ctx=%67mail&hl=en&answer=25922


Gmail

Unfortunately, Gmail does not currently support folders. There are two ways you can manage
emails.

Using an email client:

You can create folders and manage your email using an email client on your personal computer.
Then sort all of your email into organized/categorized folders or a single folder in an email client
and only leave email messages in your inbox that you are currently using.

Using SJSU Gmail:

Gmail allows you to "label" your email messages to help you sort your email into categories. If you
would like to see all emails under a certain label, the categories can be found on the left hand side
under "Labels". Once messages are labeled, you can archive these emails. Archiving messages
moves them out of your "Inbox" abut they remain in "All Mail", letting you tidy up your inbox
without deleting anything. You can also speed up your inbox by moving messages into your
"Archive".

For information on creating and managing labels in Gmail, please refer to the Google Apps Help
Center, "Labeling Mail" help topic, Click here.

Can I create folders in
Gmail?

http://mail.google.com/support/bin/answer.py?answer=6560&topic=13284


Gmail

Set up desktop notifications to avoid missing important messages from your email.

1. Sign into your gmail account.
2. Click the cog icon in the upper right corner and select Settings.
3. Under the General tab, scroll to the Desktop Notifications section.
4. Select one of the options listed:

New mail notifications on ← Recommended
Important mail notifications on
Mail notifications Off

5. Once selected, scroll down to the bottom of the page and click Save Changes.

Setting Up Gmail Desktop
Notifications



Gmail

If you have an alternate email that you would like to send emails from through your gmail account
or if you are apart of a Google Group and need to send emails on its behalf, follow the instructions
below to add the addresses.

1. Navigate to gmail.com and login to you SJSU gmail account
2. In the top right, click the gear symbol

Gmail: Send Emails from a
Google Group or Alias

Add an Address You Own

https://kb.mlml.sjsu.edu/gmail.com
https://kb.mlml.sjsu.edu/uploads/images/gallery/2022-08/1.PNG


3. Select See all settings

4. Click the Accounts and Import or Accounts tab

https://kb.mlml.sjsu.edu/uploads/images/gallery/2022-08/2.PNG


5. In the "Send mail as" section, click Add another email address.

6. In the pop-up window, enter your name and the address you want to send from. Leave
treat as an alias checked.

7. Click Next Step and Send verification

https://kb.mlml.sjsu.edu/uploads/images/gallery/2022-08/3.PNG
https://kb.mlml.sjsu.edu/uploads/images/gallery/2022-08/4.PNG
https://kb.mlml.sjsu.edu/uploads/images/gallery/2022-08/5.PNG


8. Check the address you are adding for the verification email and click on the link or enter
the verification code in the pop-up window.

1. Click Compose in the top left corner to start a new email draft
2. Click the From address line located above the To address line. A dropdown menu will

appear to change the email.

3. To test that you were successful, you can send an email to yourself from the newly added
address.

Sending Emails using an Added Address or Alias

https://kb.mlml.sjsu.edu/uploads/images/gallery/2022-08/TMO6.PNG
https://kb.mlml.sjsu.edu/uploads/images/gallery/2022-08/7.PNG


4. Note: Sending emails from a Google Group or Alias are the same once the address has
been added to your account.

For more information and troubleshooting, visit this gmail help

website.

https://support.google.com/mail/answer/22370?hl=en
https://support.google.com/mail/answer/22370?hl=en


Gmail

Delegated Gmail accounts are the secure and modern method for sharing an email
address with a group of people.
Rather than sharing a username and password with all users of the account, it can be
"delegated" to each user's personal account.
You'll log in to the shared inbox by launching it from your personal SJSU Gmail inbox page.
IT will manage which users have access to the account.
You don't need to worry about changing the password if someone leaves your group.

Create an IT Help Desk Ticket.
Include the name and SJSU email address of the user(s) that you wish to add or
remove, as well as justification

e.g. "this person needs to be added to this account because they just joined our lab"
or "this person needs to be removed from this account because they left their
position here".

They will receive an email from Google prompting them to accept the account.
The user must accept the account within 10 days, or it will expire and will need to be sent
again.

When you are added to a shared account, you'll receive an email like this:

Using a Delegated Gmail
Account

If you are a user or requester of a delegated account, please read all the information on this
page carefully

Adding or removing users from an account:

How to use an account that's been delegated to you:

https://mail.sjsu.edu/
https://isupport.sjsu.edu/mlml


Click the link under "To accept this request..." and click Confirm on the page that opens.
Now, when you click on your profile picture at the top-right corner of your SJSU Gmail
Inbox Webpage, you'll see the delegated inbox:

Click on it to open the delegated inbox. It will appear and work just like a regular Gmail
inbox.

https://kb.mlml.sjsu.edu/uploads/images/gallery/2021-12/image-1638561211599.jpg
https://mail.sjsu.edu/
https://mail.sjsu.edu/
https://kb.mlml.sjsu.edu/uploads/images/gallery/2021-12/image-1638561453079.png


Multiple people can use a delegated account at the same time.
Delegated accounts cannot be used on mobile devices, or with third-party email
programs like Outlook and Apple Mail.
By default, when you send an email from a delegated account, it will display the
individual who sent the email to recipients, like this:

If you want to disable this, so that recipients only see the address of the shared account,
please file an IT Help Desk ticket with that request.
Delegates can change most settings in Gmail, but some are restricted. If you want to
change an advanced setting (such as the display name of the account), please file an IT
Help Desk ticket.
You can also delegate Google Calendar and Contacts access. Contact IT if you want to
enable this for your group.
If you want to transfer your email archive from an old account, a member of IT will
need to retrieve the authentication code for you. Contact IT before attempting this.
You can set up email forwarding from another Gmail address just like with any other
account.
There can be no more than 25 users sharing an account.
Google's support website has more information about delegated accounts:
https://support.google.com/mail/answer/138350

Other information about delegated accounts:

https://kb.mlml.sjsu.edu/uploads/images/gallery/2021-12/image-1638565595852.png
https://helpdesk.mlml.calstate.edu/
https://helpdesk.mlml.calstate.edu/
https://helpdesk.mlml.calstate.edu/
https://kb.mlml.sjsu.edu/books/email-gmail/page/use-google-takeout-to-transfer-your-email-archive
https://kb.mlml.sjsu.edu/books/email-gmail/page/forward-email-from-your-mlml-account-to-your-sjsu-account
https://support.google.com/mail/answer/138350
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Email Client Software

To save a message as a template in macOS Mail:

1. Open Mail.app > Mailbox (in menu bar) > New Mailbox.
2. Select for the mailbox and type "Templates" into the name field.
3. Create a new message.
4. Edit the message to contain anything you want in the the template.

o You can edit and save the message subject, contents, recipients and/or the message
priority.

5. Select, File > Save as Draft from the menu.
6. Close the message editing window.
7. Go to the Drafts folder.
8. Move the message you just saved from the "Drafts" folder by dragging it to the

"Templates" folder.

 

To use a message template in macOS Mail to create a new message:

1. Open the "Templates" folder containing the desired message template.
2. Highlight the template you want to use for the new message.
3. Select Message > Send Again from the menu.
4. Edit and send the message.

You can also use any message you previously sent as a template by copying it to your "Templates"
folder (or using Message > Send Again directly). To edit a template, create a new message using it,
make the desired changes and the save the edited message as a template as described above
while deleting the old template.

Save and Use Messages as
Templates in Mac OS Mail



Email Client Software

Windows:

Outlook: C:\Users\<username>\AppData\Local\Microsoft\Outlook

Mac OS X:

Eudora: /Macintosh HD/Users/<username>/Library/Qualcomm/Eudora/
Entourage 2004: /Macintosh HD/Users/<username>/Documents/Microsoft User Data/Office 2004
Identities/Main Identity/
Entourage 2008: /Macintosh HD/Users/<username>/Documents/Microsoft User Data/Office 2008
Identities/Main Identity/

Where does my email client
store my email?



Email Client Software

Use POP if you...

...are the type of computer user who will only access your email using one email client (in this case
Outlook). This way all your email is downloaded to you computer and you will always have access
to your email whether you are online or offline. (If you use this setting, I recommend that have a
robust backup system, since the only copy of your email will reside on your personal computer. You
can configure Outlook to leave a copy of your email on the server, but you have a limited amount
of storage on the server, so your email box could reach capacity and you will no longer receive
email until you free up space.

Follow the instructions in the following link for steps to configure POP.

Use IMAP if you...

...access your email from multiple locations or devices and you are confident that you can
configure your email settings properly. The IMAP email protocol enables a user to access their
email from multiple interfaces while maintaining the presence and status of all the emails in your
account (i.e. read vs un-read, replied/forwarded, deleted/moved/sorted, etc.). This is essential if
you access your email from your computer in your office, your computer at home, your
smartphone, a web browser on a shared computer, etc. The thing about IMAP is that you need to
make sure it's configured to download the entire email message and attachments and you'll want
to backup your emails to the local hard drive on one of your computers (gmail offers backup
guarantees, but they are limited). I recommend IMAP to most computer users. It's especially helpful
if you don't have access to your computer for some reason (because it crashed, or you forgot your
power supply, or your dog ate it).

Follow the instructions in the following link for steps to configure IMAP.

Please remember that these are simply my personal preferences and recommendations, you are
responsible for configuring, maintaining and backing up your own email. I cannot take
responsibility for lost email or other problems that can result from improperly configured email
clients.

Email Configuration: IMAP or
POP3?

https://support.google.com/mail/answer/7104828?hl=en
https://support.google.com/mail/answer/7126229?hl=en


Email Client Software

1. Open Thunderbird.
2. Select Compact Folders from the File menu.
3. Wait for the folders to compact.

 

1. Open Thunderbird.
2. Go to Tools > Options > Advanced > Network & Disk Space > Disk Space.
3. Set Thunderbird to "Compact folder when it will save over 100 kB".
4. Click OK.

More information about compacting folders in Thunderbird is available here:
http://kb.mozillazine.org/Compacting_folders

Compact Thunderbird
Folders
[OLD] Compact Folders in Thunderbird to improve performance and
reliability

To compact folders manually:

To compact folders automatically (recommended):

http://kb.mozillazine.org/Compacting_folders
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You can Delete email messages from the Gmail All Mail folder using your email client:

Apple Mail:

1. Open your email client. (For this example I'll use Apple Mail)
2. Configure your email client as recommended in Gmail Help:

http://mail.google.com/support/bin/answ ... swer=78892#
Be sure that you configure Mail > Preferences > Accounts > Mailbox behaviors >
Trash > [Gmail]/Trash
Open Window > Activity - so you can view the progress of the email move
operations
Backup your email messages to a folder on your local computer using your email
client. (I recommend creating yearly archive folders for your incoming and outgoing
email messages as follows):

On My Mac (Local Folders)
ARCHIVE

IN
2008
2009

OUT
2008
2009

Move your email messages (500 - 1000 at a time) from your Inbox and Sent folders
to the corresponding folders in your email archive. (Watch the Mail Activity window
and wait until the move operation completes before moving the next set of emails or
proceeding to the next step)
Verify that you have backed up all your email messages locally as described in the
previous step and that the Mail Activity window indicates that there is no longer any
email activity, then quit Apple Mail and restart the application.
Synchronize your gmail account with Apple Mail (Mailbox > Synchronize "Google")
Quit Apple Mail and restart the application.
Now that you have backed up all your email messages and synchronized your email
account, you can start deleting email messages from the Gmail All Mail folder.

Delete Batches of Email
using an Email Client

http://mail.google.com/support/bin/answer.py?answer=78892


Click on the [Gmail] / All Mail folder in Apple Mail.
Move your oldest email messages, 500 - 1000 at a time, from "[Gmail] Gmail / All
Mail" to the "[Gmail] / Trash" folder.
(Watch the Mail Activity window and wait until the move operation completes before
moving the next set of emails or proceeding to the next step. It is recommended
that you move and delete less than 5000 emails per day.)
Synchronize your gmail account with Apple Mail (Mailbox > Synchronize "Google")
Verify that the Mail Activity window indicates that there is no longer any email
activity, then quit Apple Mail and restart the application.
Login to the SJSU Gmail web interface and click on Trash.
Click the Empty Trash now link. Click OK to confirm.
Click on All Mail then click Oldest to verify that the email messages have been
deleted from All Mail.



Through San Jose State University, you get free access to LinkedIn Learning, a service 
which contains a huge number of valuable courses on a variety of topics. We 
recommend that you explore all the topics available on LinkedIn Learning, but 
especially suggest you check out these three classes on advanced Google Workspace 
features:

SJSU G Suite: More than just Gmail
SJSU G Suite: Productivity Power
SJSU G Suite Advanced Features

Use conversation view (the default) to organize your emails more intuitively than 
traditional email inboxes

Use categorized inbox to automatically sort your incoming mail based on content.

Send messages to other people with SJSU accounts even if you don’t know their email 
address:

Google Workspace Directory means that everyone with an SJSU email address is 
already in your contacts.
If you don’t know someone’s contact info, just start typing their name into a new 
email, Chat message, Calendar event, or Google Drive “share” box, and their 
email address will come up automatic

Best practices for using your
SJSU Google Workspace
account
LinkedIn Learning

Gmail

https://one.sjsu.edu/task/all/linkedin-learning
https://www.linkedin.com/learning-login/share?account=2071660&forceAccount=true&redirect=https%3A%2F%2Fwww%2Elinkedin%2Ecom%2Flearning%2Fpaths%2Fsan-jose-state-university-sjsu-g-suite-more-than-just-gmail%3FshareId=ae969d03-30bd-4a27-b8d2-9f89fb3cb253
https://www.linkedin.com/learning-login/share?account=2071660&forceAccount=true&redirect=https%3A%2F%2Fwww%2Elinkedin%2Ecom%2Flearning%2Fpaths%2Fsan-jose-state-university-sjsu-g-suite-productivity-power%3FshareId=92d6df39-9d84-4b29-b8ea-ecf2ae013757
https://www.linkedin.com/learning-login/share?account=2071660&forceAccount=true&redirect=https%3A%2F%2Fwww%2Elinkedin%2Ecom%2Flearning%2Fpaths%2Fsan-jose-state-university-sjsu-g-suite-advanced-features%3FshareId=45c3a905-41de-4568-9fce-669cd781c77c
https://support.google.com/mail/answer/5900
https://support.google.com/mail/answer/3094499?co=GENIE.Platform%3DDesktop


Delegate your email inbox to somebody else, or to a group of people.
A delegate will be able to access your email account without knowing your 
password.
This feature is useful if a team needs to access the same account, or if you have 
an assistant.

Use Gmail templates to store a template of a message and quickly use it to send new 
emails.
Use Gmail offline to view emails when you are not connected to the internet.

Only works in Google Chrome.

Share your Calendar
You can share your free/busy schedule with anyone at SJSU, to make it easy for 
other people to schedule meetings with you
You can make your schedule available to others without sharing the details of 
the events - it’s not a security risk.

Calendar

https://support.google.com/mail/answer/138350
https://support.google.com/a/users/answer/9308990
https://support.google.com/mail/answer/1306849
https://support.google.com/calendar/answer/37082


Share event details with specific people, like your manager and others that you 
work closely wit

Schedule a Zoom meeting directly from your Calendar by clicking Add video 
conferencing

Create appointment slots to make it easy for many people to schedule appointments 
with you during a set duration.

Appointment slots are especially useful for office hours.

 

Only use your “My Drive” account folder for “personal” work documents that you do 
not need to share with others.
Use Shared Drives for any work that is shared by a team of people

Rather than individual files or a folder with your team, a Shared Drive is not 
owned by any specific account, so if someone leaves a team or takes over a 
project, you don’t have to worry about which files were stored in their Drive. 
You can add people to the Shared Drive and they will automatically get access to 
all files inside it.
People can be assigned various levels of permissions over the Shared Drive and 
files inside it.
You can still share and change permissions on individual files within the Shared 
Drive if you want more granular control.

Use Google Drive for Desktop to sync files between computers, and back up files to 
the Google Drive cloud.

Google Drive for Desktop is similar to Dropbox and other cloud syncing 
programs, but with your SJSU Google account, you get unlimited storage.
Sharing is also integrated with the Google Workspace directory, making it easy 
to share files with anyone else at MLML and SJSU.
You can use Google Drive for Desktop to access files without the internet

Google Drive

https://support.google.com/calendar/answer/190998
https://support.google.com/a/answer/7212025
https://support.google.com/a/users/answer/9965580


You can sign in with multiple Google accounts. Each account syncs to its own 
folder on your computer, as well as any Shared Drives you have.

You can create your own Google Groups at groups.sjsu.edu. Groups are like bulletin 
board systems, which can be used to send messages to and start conversations with 
members of the group. 
Make sure to always have a backup “owner” of your Group to make sure no one gets 
locked out.

Sync your Google Contacts to an iPhone using this guide: Configure email on your 
phone and other third-party email programs
You can delegate access to your contacts just like with a Gmail inbox.

Google Chat has nearly all of the functionality of professional workspace messaging 
systems like Slack and Microsoft Teams, with the big benefit that you can message 
anyone with an SJSU account or even external Google accounts.
Three types of conversations:

One-on-one with another person.
Groups, which are like text message groups where every person gets notified. 
Best for small groups where everyone is involved.
Rooms, which are more like channels in Slack. Each topic is a new thread, and 
people can choose which ones they want to be notified for. Best for large groups, 
like an entire lab, where each conversation may not be relevant to every 
participant.

You can use Chat from within the Gmail webpage and Gmail phone apps, or you can 
use the separate Chat apps for Desktop, Android, and iOS.
Use the @Zoom chatbot to start a Zoom meeting with the members of any chat.

Google Groups

Contacts

Google Chat

http://groups.sjsu.edu
https://kb.mlml.sjsu.edu/books/email-gmail/page/configure-email-on-your-phone-and-other-third-party-email-programs
https://kb.mlml.sjsu.edu/books/email-gmail/page/configure-email-on-your-phone-and-other-third-party-email-programs
https://support.google.com/contacts/answer/2590392
https://chat.google.com/
https://mail.google.com/chat/u/0/#chat/welcome
https://play.google.com/store/apps/details?id=com.google.android.apps.dynamite
https://apps.apple.com/us/app/google-chat/id1163852619


Google also includes a video conferencing service called Meet, but we 
recommend that you use Zoom. It has more features and is integrated with other 
SJSU services. 

You may have signed in to other websites and services, such as Dropbox, Apple 
iCloud, LinkedIn, and many more, with your MLML email address in the past. Though 
you may not even remember all of them right now, we recommend working on 
switching them to using your SJSU email address. 
In particular, you may have used your email address to get educational discounts or 
free services. SJSU accounts should have access to all these and possibly even more. 
Visit the SJSU software webpage for more information.
Most websites will make it simple to change your email address; just log in and locate 
your account settings. 

You should already be familiar with Duo, which is SJSU’s solution for 2-factor 
authentication on your account. 
The MLML Duo documentation covers the options you have for signing in. 
We recommend using the mobile app, or a hardware token if you do not have a 
smartphone/tablet with reliable internet access. 

File an IT Helpdesk Ticket if you need a hardware token.
SMS and phone call authentication are not supported.
Duo Mobile is accessible under Section 508 of the Rehabilitation Act of 1973.
U2F/FIDO hardware keys are technically supported, but only work for 
authentication within browsers and not other applications like the VPN.

Use Google Security Checkup to review:
The devices and browsers you’re signed into
Recent activity on your Google account
Your methods of authentication

Third-party Accounts:

Duo

Google Security Checkup

https://www.sjsu.edu/it/services/collaboration/software/instructions.php
https://kb.mlml.sjsu.edu/books/security-anti-malware/chapter/duo-2-factor-authentication
https://myaccount.google.com/security-checkup


Third-party apps with access to your Google account
Your saved passwords

Use the official Google Apps (Gmail, Calendar, etc.) rather than the built-in Apple 
apps.

Apple’s apps are not compliant with Gmail features and standards.
There are two exceptions:

Sign into the iOS Mail app and enable only contact syncing, as outlined in this 
guide: Configure email on your phone and other third-party email programs
On a Mac, sign into the Calendar app so you can get desktop notifications even 
when your browser is closed.

Using SJSU Google Services on Apple Operating Systems

https://apps.apple.com/us/app/gmail-email-by-google/id422689480
https://apps.apple.com/ky/app/google-calendar-get-organised/id909319292
https://apps.apple.com/ky/developer/google-llc/id281956209
https://kb.mlml.sjsu.edu/books/email-gmail/page/configure-email-on-your-phone-and-other-third-party-email-programs


Both Google Chrome and Mozilla Firefox provide features that allow you to use multiple Gmail accounts at 
the same time, but keep them separate. This is helpful if you want to use some websites while signed into 
your SJSU Gmail account and others signed in with your personal account or an account from another 
facility, and avoid confusion about which is which.

Chrome:
Google Chrome lets you sign into multiple Google accounts each with its own window. Each profile will be 
completely separate, with its own bookmarks, browsing history, browser add-ons, and stored passwords. 
This is useful for keeping your personal information and bookmarks separate from your work/school 
accounts, as well as keeping multiple work/school accounts separate from each other. 

1. Open Chrome and click your profile icon in the top right.

Use multiple Google
accounts simultaneously
with browser profiles and
containers



2. At the bottom of the menu that appears, click + Add.

3. A new window will appear. Sign in with the Google account that you wish to add. 

NOTE: If you are signing into an SJSU account, you will be redirected to a webpage to login 

with your SJSU ID and authenticate with Duo.

https://kb.mlml.sjsu.edu/uploads/images/gallery/2022-08/35G1.png


4. Now that you have added a second profile, when you launch Chrome you will be presented with a 

window showing all of your profiles and letting you choose which one you want to launch

5. Click the icon with three vertical dots on each profile to access its preferences

6. Set a different browser theme and picture for each one, so you can tell which account you are 

using at a glance.

7. You can also create a desktop shortcut for each profile (Windows only).

https://kb.mlml.sjsu.edu/uploads/images/gallery/2022-08/jQv2.png
https://kb.mlml.sjsu.edu/uploads/images/gallery/2022-08/3.png


8. We recommend creating at least two profiles: 

One for your personal email and non-MLML-related usage.

One for your SJSU Google account.

An important note about applications that use Single Sign-On (SSO), like Zoom, Google Drive for 
Desktop, and Adobe Creative Cloud:

When you sign in to these applications, they open a browser window, so you can authenticate with 
whichever accounts you are already signed into in your browser. 

If you try to use an SSO application with Chrome’s multiple browser profiles, Chrome will open the 

sign-on page in whichever profile you most recently clicked on. 

To ensure that SSO applications work correctly, simply ensure that you click on the appropriate 

Chrome window (in which you are signed into the account that will be used with the app) before 
clicking the sign in button in the app itself.

For more documentation on Google Chrome profiles, view the Google help page.

Firefox uses a different approach for allowing you to keep accounts separate. Rather than completely 
separate browser profiles, Firefox lets you open tabs in different “containers”, each of which has its own 
accounts and stored cookies. Bookmarks, browsing history, and browser add-ons, however, are shared 
across all containers.

 

1. To use Firefox containers, install this official browser add-on from Mozilla.

Firefox:

https://support.google.com/chrome/answer/2364824
https://addons.mozilla.org/en-US/firefox/addon/multi-account-containers/


2. When the add-on is installed, you will see a new button in the top right corner of the Firefox 

window.

3. Clicking one of the containers in the bottom section will open a new tab in that container. You can 
have any number of tabs in any container open. 

4. Containers will be differentiated by the colored line across the top of each tab



5. Clicking Manage Containers will allow you to create, edit, or delete your containers.

Firefox comes with a few by default (Personal, Work, Banking, Shopping), but we 

recommend that you make one container for your SJSU Google account and another one 
for your personal Google account.

6. You can also click Always Open This Site in…  to assign a website to a particular container.

For example, you could assign one.sjsu.edu to your SJSU container, so if you click a link in 

another tab, it will be switched over to the appropriate container with your SJSU account.

An important note about applications that use Single Sign-On (SSO), like Zoom, Google Drive for 
Desktop, and Adobe Creative Cloud: 

When you sign in to these applications, they open a browser window, so you can authenticate with 

whichever accounts you are already signed into in your browser. 

If you try to use an SSO application Firefox containers enabled, it will not open in any container by 

default, and you may not be able to reopen the sign-on page in a particular container since it may 
use a unique link that only works once.

To ensure that SSO applications work correctly, you can assign the application’s sign-in page to 

the appropriate container, as described above. If this doesn’t work, you may need to use a 
different browser to sign in.

For more documentation on Firefox containers, view the Mozilla help page.

https://one.sjsu.edu/
https://support.mozilla.org/en-US/kb/containers


We do not recommend using Apple’s built-in apps for email and calendar on your iPhone or 
iPad because they lack support for many features in Gmail and Google Calendar.

Instead we recommend downloading the following apps from the App Store:

Gmail
Google Calendar
Google Drive
Google Tasks
Google Chat
Google Chrome (if you want to sync your bookmarks, passwords, and browsing history 
with Chrome on your computer)

If you have already signed into Apple’s Mail app with your Gmail account, we recommend only 
syncing your contacts.

1. Open the Settings app
2. Scroll to find Mail and click on it
3. Select your gmail account

Configure email on your
phone and other third-party
email programs
iOS (iPhones and iPads):

https://apps.apple.com/us/app/gmail-email-by-google/id422689480
https://apps.apple.com/us/app/google-calendar-get-organized/id909319292
https://apps.apple.com/us/app/google-drive/id507874739
https://apps.apple.com/us/app/google-tasks-get-things-done/id1353634006
https://apps.apple.com/us/app/google-chat/id1163852619
https://apps.apple.com/us/app/google-chrome/id535886823


4. Enable Contacts only

Similarly to iOS, we do not recommend using the built-in macOS apps like Mail and Calendar, 
and instead using the G Suite's webpage interfaces.

We recommend using Gmail and other Google apps on Android. Nearly all Android phones will 
have these apps preinstalled. For instructions on how to sign in, follow this guide.

Third-party desktop email programs, like Microsoft Outlook, are not recommended. If you need 
to access your email offline, you can enable offline access by following these instructions.
 
If you really want to use a desktop email program, follow these instructions to log in with 
Gmail:

Outlook

macOS:

Android:

Desktop Mail Programs

https://support.google.com/mail/answer/8494?co=GENIE.Platform%3DAndroid
https://support.google.com/mail/answer/1306849
https://support.microsoft.com/en-us/office/add-a-gmail-account-to-outlook-70191667-9c52-4581-990e-e30318c2c081


Other third-party apps

https://support.google.com/mail/answer/7126229

